# Table of Contents

Table of Contents .......................................................................................................................... 2

**Extreme Management Center® Suite Installation** ................................................................. 4

General Information ....................................................................................................................... 4

Operating System Requirements .................................................................................................... 4

Extreme Management Center Server Requirements ................................................................. 4

Extreme Management Center Client Requirements ................................................................. 5

Extreme Management Center Server and Client Hardware Requirements ..................... 5

Extreme Management Center Server .......................................................................................... 5

Extreme Management Center Client .......................................................................................... 5

ExtremeControl Engine Version Requirements ........................................................................... 5

Screen Resolution .......................................................................................................................... 6

Evaluation License ......................................................................................................................... 6

Extreme Management Center Services ......................................................................................... 6

Upgrade Information ...................................................................................................................... 7

Important Upgrade Considerations ............................................................................................... 8

Upgrading an Evaluation License .................................................................................................. 8

Upgrading to Extreme Management Center NAC Manager 8.5 .............................................. 9

General Upgrade Information ....................................................................................................... 9

Agent Version for NAC Agent-Based Assessment ..................................................................... 9

Upgrading to Policy Manager 8.5 ................................................................................................. 10

Upgrading to Wireless Manager 8.5 ............................................................................................ 10

Pre-Installation Checklist ............................................................................................................. 10

Extreme Management Center Installation .................................................................................... 11

Preparing for CD Installation ....................................................................................................... 12
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install and Launch Extreme Management Center</td>
<td>13</td>
</tr>
<tr>
<td>Performing a Silent Install</td>
<td>16</td>
</tr>
<tr>
<td>Post Installation Procedure for Ubuntu 18.04 LTS (Bionic Beaver)</td>
<td>17</td>
</tr>
<tr>
<td>Restoring a Database from a Windows Server to a Linux Server</td>
<td>17</td>
</tr>
<tr>
<td>Console</td>
<td>17</td>
</tr>
<tr>
<td>Syslog</td>
<td>18</td>
</tr>
<tr>
<td>Traps</td>
<td>18</td>
</tr>
<tr>
<td>Inventory Manager</td>
<td>18</td>
</tr>
<tr>
<td>Systems with Multiple NICs</td>
<td>19</td>
</tr>
<tr>
<td>Binding to One Interface</td>
<td>19</td>
</tr>
<tr>
<td>Remote Client Launch</td>
<td>19</td>
</tr>
<tr>
<td>Uninstalling Extreme Management Center</td>
<td>20</td>
</tr>
<tr>
<td>Extreme Networks Support</td>
<td>20</td>
</tr>
</tbody>
</table>
Extreme Management Center® Suite Installation

This document provides instructions for installing and launching Extreme Management Center, and for launching Extreme Management Center applications on remote Extreme Management Center clients. It also includes information for those upgrading from an earlier version of Extreme Management Center.

**IMPORTANT:** Backup the Extreme Management Center database prior to performing the upgrade and save it to a safe location. Use the **Administration > Backup/Restore** tab.

**General Information**

Before you install Extreme Management Center, read the *Extreme Management Center Release Notes*. The most recent version of these release notes can be found at the [Extreme Management Center Documentation site](#). Click **Release Notes** at the top of the page.

**NOTE:** The terms engine, gateway, and appliance are used interchangeably throughout Extreme Management Center documentation.

**Operating System Requirements**

**Extreme Management Center Server Requirements**

These are the operating system requirements for the Extreme Management Center server.

<table>
<thead>
<tr>
<th>Manufacturer</th>
<th>Operating System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linux</td>
<td>Red Hat Enterprise Linux WS and ES v6 and v7</td>
</tr>
<tr>
<td></td>
<td>Ubuntu 18.04</td>
</tr>
<tr>
<td>VMware® (Extreme Management Center Virtual Engine)</td>
<td>VMware ESXi™ 6.0 server</td>
</tr>
<tr>
<td></td>
<td>VMware ESXi™ 6.5 server</td>
</tr>
<tr>
<td></td>
<td>VMware ESXi™ 6.7 server</td>
</tr>
<tr>
<td></td>
<td>VMware ESXi™ 7.0 server</td>
</tr>
<tr>
<td></td>
<td>vSphere (client only)™</td>
</tr>
<tr>
<td>Hyper-V (Extreme Management Center Virtual Engine)</td>
<td>Hyper-V Server 2012 R2</td>
</tr>
<tr>
<td></td>
<td>Hyper-V Server 2016</td>
</tr>
</tbody>
</table>
Extreme Management Center Client Requirements

These are the operating system requirements for remote Extreme Management Center client machines.

<table>
<thead>
<tr>
<th>Manufacturer</th>
<th>Operating System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows (qualified on the English version of the operating systems)</td>
<td>Windows® 10</td>
</tr>
<tr>
<td>Linux</td>
<td>Red Hat Enterprise Linux WS and ES v6 and v7 Ubuntu 18.04</td>
</tr>
<tr>
<td>Mac OS X®</td>
<td>El Capitan Sierra</td>
</tr>
</tbody>
</table>

Extreme Management Center Server and Client Hardware Requirements

These are the hardware requirements for the Extreme Management Center server and Extreme Management Center client machines:

Extreme Management Center Server

<table>
<thead>
<tr>
<th></th>
<th>Small</th>
<th>Medium</th>
<th>Enterprise</th>
<th>Large Enterprise</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total CPUs</td>
<td>1</td>
<td>2</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>Total CPU Cores</td>
<td>8</td>
<td>16</td>
<td>16</td>
<td>16</td>
</tr>
<tr>
<td>Memory</td>
<td>16 GB</td>
<td>32 GB</td>
<td>64 GB</td>
<td>64 GB</td>
</tr>
<tr>
<td>Disk Size</td>
<td>240 GB</td>
<td>480 GB</td>
<td>960 GB</td>
<td>1.92 TB</td>
</tr>
<tr>
<td>IOPS</td>
<td>200</td>
<td>200</td>
<td>10,000</td>
<td>10,000</td>
</tr>
</tbody>
</table>

Extreme Management Center Client

<table>
<thead>
<tr>
<th>Requirements</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU Speed</td>
<td>3.0 GHz Dual Core Processor</td>
</tr>
<tr>
<td>Memory</td>
<td>4 GB</td>
</tr>
<tr>
<td>Disk Size</td>
<td>300 MB (User’s home directory requires 50 MB for file storage)</td>
</tr>
<tr>
<td>Java Runtime Environment (JRE) (Oracle Java only)</td>
<td>Version 8</td>
</tr>
<tr>
<td>Browser* (Enable JavaScript and Cookies)</td>
<td>Microsoft Edge (version 41.16.199.10000.0 in compatibility mode) Mozilla Firefox (version 34 or later*) Google Chrome (version 33.0 or later)</td>
</tr>
</tbody>
</table>

ExtremeControl Engine Version Requirements

For complete information on ExtremeControl engine version requirements, see the Upgrade Information section of these Installation instructions.
Screen Resolution

For optimum display of Extreme Management Center windows and tables, the recommended minimum screen resolution setting for Extreme Management Center clients is 1024 by 768 pixels. For optimum display of graphs and tables, the recommended minimum screen resolution setting is 1280 by 1024 pixels.

Evaluation License

If you request an Extreme Management Center evaluation license, you receive an Entitlement ID. This Entitlement ID allows you to generate a product evaluation license key. Refer to the instructions included with the Entitlement ID to generate the license key. Use the key when you install the product.

To install Extreme Management Center using an evaluation license, refer to the Extreme Management Center Installation instructions for Linux contained in this guide.

To upgrade from an evaluation license to a purchased license, see the instruction in the Upgrading an Evaluation License section.

Extreme Management Center Services

During the Extreme Management Center installation, you can enable the Extreme Management Center Services, allowing it to run in the background on the Extreme Management Center server. The service starts automatically by default, and if you shut down and restart the machine, the service is restarted automatically.

You can also restart the services manually or disable a service so it does not start automatically when you restart the server.

- **SNMPTrap Service** - Enables SNMP trap messages to be received and logged when problems or irregularities are detected on network devices. Only one trap service may be running at a time on a server. If you are also running a network management system on the server, you may wish to use the network management trap service.

- **TFTP** - Enables you to upload and download configuration files, and download firmware to devices. Only one TFTP service may be running at a time on a machine.

**NOTE:** The Extreme Management Center TFTP Service does not support IPv6.

Typically, the TFTP service that exists in Linux is disabled; however, if it is enabled, you may wish to disable it and enable the Extreme Management Center
version of TFTP which provides additional features for Extreme Management Center. If you elect to enable the Extreme Management Center version on the Linux platform, you must first disable the Linux TFTP service and perform some configuration as follows:

1. Using a text editor, edit the file /etc/xinetd.d/tftp
2. Set disable = yes
   Sample file:
   ```
   service tftp {
   flags = REUSE
   socket_type = stream
   wait = no
   user = root
   server = /usr/sbin/in.tftp
   disable = yes
   }
   ```
3. Then run: /etc/rc3.d/S56xinetd restart

**Upgrade Information**

Extreme Management Center 8.5 supports upgrades from Extreme Management Center version 8.2.x (except version 8.2.2) or 8.3.x. If you are upgrading from version 8.1 or earlier of NetSight/Extreme Management Center, you must perform an intermediate upgrade. For example, if you are upgrading from NetSight 7.1, you must first upgrade to the latest Extreme Management Center 8.1 release, then upgrade to the latest Extreme Management Center 8.2 or 8.3 release, then to 8.5.

**IMPORTANT:** When performing an upgrade, be sure to backup the Extreme Management Center database prior to performing the upgrade, and save it to a safe location. Use the Administration > Backup/Restore tab to perform the backup. Backup functionality is enhanced in version 8.0 of Extreme Management Center and may function differently depending on the method used by your version of Extreme Management Center.

When upgrading the Extreme Management Center server, ExtremeAnalytics engine, or ExtremeControl engine to version 8.5, ensure the DNS server IP address is correctly configured.

During the installation (if upgrading using the user interface installer), you have the option to backup additional user files by selecting a checkbox on the Previous Installation Detected screen. This option lets you backup user files such as Inventory
Manager archive files not automatically backed up during the install because the backup could take several minutes.

**Important Upgrade Considerations**

- If your network is using ExtremeAnalytics or ExtremeControl engines, Fabric Manager, or another add-on feature, you must first perform the Extreme Management Center upgrade to version 8.5 and then add the feature.

- If you are running Data Center Manager (DCM), a Mobile Device Management (MDM) integration, or other OneFabric Connect or Fusion integration with Extreme Management Center:
  - The OneFabric connect module is disabled on upgrade, and requires a new version in order to operate with Extreme Management Center 8.5. You must install an updated module that supports Extreme Management Center 8.5. Contact your account team for information on obtaining this update.
  - You must install an Extreme Management Center Advanced (NMS-ADV) license with 8.5 when you upgrade. Contact your account team for information on obtaining this license.

- If you are accessing Web Services directly or through OneFabric Connect you need to install an Extreme Management Center Advanced (NMS-ADV) license. Contact your account team for information on obtaining this license.

- When upgrading a 64-bit Extreme Management Center server or when upgrading from a 32-bit to a 64-bit Extreme Management Center server, if the -Xmx setting is set below 1536m, it is increased to 1536m.

- Upgrading to Extreme Management Center version 8.5 requires you to renew your [NMS license](#) if generated prior to November 30, 2018. Licenses generated prior to November 30, 2018 expire 90 days after upgrading to Extreme Management Center version 8.5.

- The 4.xx version of the NAC Request Tool is not compatible with the 8.5 Extreme Management Center server. If you are using the NAC Request Tool you need to upgrade the version of NAC Request Tool to version 8.5.

**Upgrading an Evaluation License**

To upgrade from an evaluation license to a purchased copy, contact your Extreme Networks Representative to purchase the software and receive an Entitlement ID. You do not need to reinstall the software to perform the conversion.
Prior to installing Extreme Management Center, you should redeem your Entitlement ID for a product license key. Refer to the instructions included with the Entitlement sent to you.

If your Evaluation copy has not expired:

1. Open the Administration > Diagnostics > Server > Server Licenses.
2. In the tab, click Add.
3. Enter the license text that you received when you generated the product license key.
4. Click OK. The license file is updated with the new license text.

If you have let your Evaluation Copy expire, when you launch Extreme Management Center a window opens where you can enter the license text.

**Upgrading to Extreme Management Center NAC Manager 8.5**

**General Upgrade Information**

When upgrading to Extreme Management Center NAC Manager 8.5, you are not required to upgrade your ExtremeControl engine version to 8.5. However, both NAC Manager and the ExtremeControl engine must be at version 8.5 in order to take advantage of the new ExtremeControl 8.5 features. Extreme Management Center NAC Manager 8.5 supports managing ExtremeControl engine versions 8.2, 8.1, and 8.0.

**NOTE:** ExtremeControl 8.5 is not supported on the 2S Series and 7S Series NAC Controllers. You cannot upgrade ExtremeControl Controllers to version 8.5, but you can use NAC Manager 8.5 to manage controllers running version 4.3.xx.

You can download the latest ExtremeControl engine version at the [Extreme Portal](#). Be sure to read through the Upgrading to ExtremeControl 8.5 document (available on the Extreme Management Center [Documentation](#) page for important information.

In addition, if your ExtremeControl solution utilizes a Nessus assessment server, you should also upgrade your assessment agent adapter to version 8.5 if you upgrade to ExtremeControl 8.5.

**Agent Version for NAC Agent-Based Assessment**

If you are using onboard agent-based assessment, be aware that the agent version is upgraded during the ExtremeControl engine software upgrade. If you would like end-
systems to update their agent to the new version, you must configure your assessment test set to test for the new agent version. Refer to the Upgrade Information section in the Extreme Management Center Release Notes for the agent version included in the ExtremeControl engine software.

Upgrading to Policy Manager 8.5

- Policy Manager 8.5 only supports ExtremeWireless Controller version 8.01.03 and higher. If you upgrade to Extreme Management Center 8.5 prior to upgrading your controllers, then Policy Manager does not allow you to open a domain where the controllers already exist or add them to a domain. A dialog is displayed indicating your controllers do not meet minimum version requirements and that they must be upgraded before they can be in a domain.

- Following an upgrade to Wireless Controller version 8.31 and higher, a Policy Manager enforce fails if it includes changes to the default access control or any rules that are set to contain. To allow Policy Manager to modify the default access control or set rules to contain, you must disable the "Allow action in policy rules contains to the VLAN assigned by the role" checkbox accessed from the Wireless Controller's web interface on the Roles > Policy Rules tab. This will allow the enforce operation to succeed.

Upgrading to Wireless Manager 8.5

Following a Wireless Manager upgrade, you should clear the Java Cache before starting the Extreme Management Center client.

Pre-Installation Checklist

Please review the following checklist prior to performing an Extreme Management Center software installation or upgrade.

- **Backup database.** If performing an upgrade, be sure to backup the Extreme Management Center database prior to performing the upgrade. Use the Backup/Restore tab to perform the backup (Administration > Backup/Restore tab).

- **Disable antivirus software.** Disable any antivirus software running on the Extreme Management Center server prior to beginning the installation. Be sure to re-enable the antivirus software following the install.
Extreme Management Center Installation

**NOTE:** Installing Extreme Management Center on a system on which McAfee version 8.0 is installed may prevent the installation from completing successfully without displaying an error message. Ensure you disable McAfee before installing.

- **Generate your Extreme Management Center product license key.** When you purchased Extreme Management Center, you received a Licensed Product Entitlement ID for the license that you purchased. This Entitlement ID allows you to generate a product license key. Refer to the instructions included with the Entitlement ID to generate the license key. You use the key when you install the product.

---

**Extreme Management Center Installation**

Use the following instructions to install Extreme Management Center. Please read through the following items before beginning the installation.

- The user performing the installation must be the root user. During the installation process you can specify another user to launch and run the server, if desired.
- If you are installing Extreme Management Center on a Linux system that doesn't support a GUI, see [Performing a Silent Install](#) for information on installing Extreme Management Center without using its GUI Installation wizard.
- If you are installing Extreme Management Center on a Linux system that requires an operating system upgrade, you are prompted to upgrade using either an internet connection or locally if no additional Ubuntu packages need to be installed.
- Prior to beginning installation, verify that your /etc/hosts file has the local host name specified. It should have an entry that looks like:
  ```
  127.0.0.1 localhost
  ```
- You may encounter a Java exception during the install when becoming the root user with the su - command. Be sure that your system's root environment has a proper DISPLAY variable setting. The Installation program reports a Java exception (InvocationTargetException) if the DISPLAY variable is undefined. If this occurs:

  Before using the su - command, set the system display variable to accept a remote display with the command:
  ```
  /usr/openwin/bin/xhost +test 111 lll
  ```

  After using the su - command, set the display variable in the environment where the su - was done.

  For C shell: `setenv DISPLAY :0.0`
For Korn shell: `export DISPLAY=:0.0`

**Preparing for CD Installation**

Perform the following steps if you will be installing the Extreme Management Center software from a CD. The following procedures assume that the CD drive from which you are installing is physically attached to the system where Extreme Management Center is being installed.

1. Insert the Extreme Management Center CD into the CD drive.
2. Use an xterm where you are logged in as root. (Be sure that your system's root environment has a proper DISPLAY variable setting. For more information see the above note.)
3. Using the cd command, cd to the `/mnt/cdrom` directory.
4. Using the ls command, check to see if the CD drive is mounted. If no files are listed, issue the following commands:
   `mount /mnt/cdrom`
Install and Launch Extreme Management Center

1. Download the Extreme Management Center software from the Network Management Suite (NMS) Download web page
2. Use an xterm where you are logged in as root. (Be sure that your system’s root environment has a proper DISPLAY variable setting. For more information see the above note.)
3. Change the permissions on the upgrade file by entering the following command:
   
   chmod u+x File_Name_<version>_install.bin
4. If installing Extreme Management Center on a system on which Ubuntu 18.04 LTS (Bionic Beaver) is installed, continue to step 5; otherwise, proceed to step 9.
5. Edit the rsyslog.conf file.
6. Uncomment (remove the # from the beginning of the line) for the lines that include imudp/514 and imtcp/514:

   #ENABLE_RSYSLOG_SERVICE
   cp /etc/rsyslog.conf /etc/rsyslog.conf.original
   sed -i 's/#module(load="imudp")/module(load="imudp")/g' /etc/rsyslog.conf
   sed -i 's/#input(type="imudp" port="514")/input(type="imudp" port="514")/g' /etc/rsyslog.conf
   sed -i 's/#module(load="imtcp")/module(load="imtcp")/g' /etc/rsyslog.conf
   sed -i 's/#input(type="imtcp" port="514")/input(type="imtcp" port="514")/g' /etc/rsyslog.conf
   systemctl restart rsyslog
7. Edit the /etc/hosts file.
8. Ensure the ip fqdn hostname line is configured (the last line in the following codeblock):

   #IF_DNS_NOT_CONFIGURED
   hostnamectl set-hostname <set_your_hostname_here>
   domainname <set_your_domain_here>
   export HOST_IP=`hostname -i|awk '{print $1}'`
   export HOST_FQDN=`hostname -f`
   export HOST_NAME=`hostname`
   cp /etc/hosts /etc/hosts.original
   echo $HOST_IP $HOST_FQDN $HOST_NAME >> /etc/hosts
   #
# If DNS is configured on the system ensure the /etc/hosts contains an
# entry of the format:
# <ip> <fqdn> <hostname>
# 192.168.1.150 xmc1804.extremenetworks.com xmc1804

9. Start the Installer.

- **If you have downloaded the software**, cd to the directory where you downloaded the installer and start the Installer with the following command:
  
  ```
  ./ExtremeManagementCenter_Suite_<version>_64bit_install.bin
  ```

- **If you are installing from a CD**, start the installer with the command:
  
  ```
  /mnt/cdrom/ExtremeManagementCenter.bin
  ```

10. The Extreme Management Center Installer leads you through a series of windows that ask for all the information required in order to install Extreme Management Center. You need the following information for the Installer Program:

- **License Text** - Enter the license text for the Extreme Management Center license you purchased. You received the license text when you generated your Extreme Management Center product license key. If you choose not to enter the license text during the installation, you will be asked to enter it the first time you launch an individual Extreme Management Center application.

- **Service Configuration** - There are two Service Configuration screens.
  
  - In the first screen, you can specify a user other than root to own the Extreme Management Center server and its supporting files, if desired. This user becomes the admin user for the server. Select **Use existing user** if you already have a user defined on the machine and enter the user name. Select **Create local netsight user** if you want to create a new "netsight" user (netsight is the user name) and enter the password for this new user. Leave the **Use existing user** option set to **root** if you do not want to specify another user.
  
  - In the second screen, enable and start the Extreme Management Center Services. (For more information on the services offered on the Linux platform, see Extreme Management Center Services.)

- **Destination Directory** - This is the path to your Extreme Management Center Installation Directory. In the Destination Directory window, click **Choose** to navigate to the directory, or type the path in manually.

- **Operating System Upgrade Method** – If your Linux system requires an operating system upgrade, you are prompted to upgrade using either an
internet connection or locally (without an internet connection) if no additional Ubuntu packages need to be installed:

!!! ATTENTION !!!

We can attempt to upgrade the OS without using the Internet if there were no extra Ubuntu packages installed. If there were extraneous packages installed, the upgrade will fail with this method.

Do you want to attempt a local in-place upgrade of the OS and reboot when complete? (Y/n)

When you have finished with this series of windows, Extreme Management Center is installed according to your specifications.

11. When the installation is complete, the database and server are started automatically. You must wait until the Extreme Management Center server has started all its various server components before you can connect to the server and launch the Extreme Management Center applications. On the installation screen, you see an hourglass icon while the server starts its components. When the server is ready for connections, the installation screen displays a green check.

12. On the installation screen, click on the **Show Launch Page** link to open the Extreme Management Center Launch Page.

13. The Extreme Management Center Launch Page opens. At the top of the web page you will see tabs for the following functions:

   - **Home** - Launch your Extreme Management Center applications by clicking on the names or icons of any of the listed applications.

   - **Getting Started** - In order to launch your Extreme Management Center applications, you must have Java Runtime Environment (JRE) 6 (also referred to as 1.6) or higher installed on your system. This page tells you if you have met this requirement and provides instructions for installing the Java Runtime Environment (JRE), if required.

   - **Administration** - Provides access to specific server administration functions such as client and server diagnostics, and server utilities.

14. Verify that you have met the JRE requirement by accessing the **Getting Started** tab, and install the JRE according to the instructions on the **Install Java** tab, if required.

15. Click on the **Home** tab and launch the desired Extreme Management Center application by clicking the name or icon.
16. A login window appears. Extreme Management Center requires a user login as a way to restrict access to the Extreme Management Center server, perform audit trails, and assign user capabilities according to the Authorization Group the user belongs.
   a. Select the Extreme Management Center server to which you wish to connect.
   b. Enter your username.
   c. Enter your password and click OK.

   **NOTES:** The initial user to log in must be the user that performed the Extreme Management Center installation, which is either root or the user defined in the Service Configuration screen during the installation. This is because the Extreme Management Center server has a single pre-defined user. Once the initial user has logged in, additional users can be defined.

   The password for the root user does not expire. To configure the password to age so it expires after 60 days, see Configure Your Password to Expire.

17. The application main window opens.

### Performing a Silent Install

If you are installing Extreme Management Center on a Linux system that doesn't support a GUI, you must add the cli flag (--cli) to the install command, in order to allow the Extreme Management Center installer to prompt for any required input.

Start the installation with the following command:

```
./ExtremeManagementCenter_Suite_<version>_64bit_install.bin --cli
```

If you are installing as a user other than root, you must use the --user command to specify the different user. The user must already be configured on the machine before you install. For example:

```
./ExtremeManagementCenter_Suite_<version>_64bit_install.bin --cli --user <username>
```

To perform the install and create a new local "netsight" user (where netsight is the user name), use the --password command to set the password for the new "netsight" user. For example:

```
./ExtremeManagementCenter_Suite_<version>_64bit_install.bin --cli --password <password>
```
Post Installation Procedure for Ubuntu 18.04 LTS (Bionic Beaver)

If installing Extreme Management Center on a system on which Ubuntu 18.04 LTS (Bionic Beaver) is installed, follow this procedure once Extreme Management Center is installed:

1. Open a command prompt on the Extreme Management Center server.
2. Enter `cp /var/Extreme_Networks/.netsight /var/Extreme_Networks/.netsight.original`.
3. Enter `export HOST_IP=`hostname -i|awk '{print $1}'`.
4. Enter `sed -i "\$aJBOSS_HOSTNAME=$HOST_IP" /var/Extreme_Networks/.netsight`.
5. Install OpenSSH for SCP-based archives support and allow root login:
   a. Open the `/etc/ssh/ssh_config` file and change `PermitRootLogin` to `yes`.
   b. Enter `apt-get install openssh-server`.
6. Allow root access to the Extreme Management Center server via SSH.
   a. Enter `cp /etc/ssh/ssh_config /etc/ssh/sshd_config.original`.
   b. Enter `sed -i 's/#PermitRootLogin prohibit-password/PermitRootLogin yes/g' /etc/ssh/sshd_config`.

Restoring a Database from a Windows Server to a Linux Server

This section describes several Extreme Management Center configuration changes required if you are moving your Extreme Management Center installation from a Windows platform system to a Linux platform system. The steps are performed after restoring your database to the new server.

In addition, there are two changes that must be made in the legacy Console java application and one change in the legacy Inventory Manager application.

Console

Use the following instructions to change the location of syslog and trap information to the new location on the Linux system.
Syslog

Change the Syslog Log Manager to point to the new location on the Linux system. This allows the display of syslog information in the **Syslog Event View** tab.

1. From the Console menu bar, select **Tools > Alarm/Event > Event View Manager**.
2. Click on the Syslog entry under Available Log Managers, and click the **Edit** button. The Log Manager Parameters window opens.
3. Change the path in the Log Directory field to `/var/log/syslog`.
4. Change the Pattern to Red Hat LINUX Syslog Pattern.
5. Click **OK**.

Traps

Change the Traps Log Manager to point to the new location on the Linux system. This allows the display of trap information in the **Traps Event View** tab.

1. From the Console menu bar, select **Tools > Alarm/Event > Event View Manager**.
2. Click on the Traps entry under Available Log Managers, and click the **Edit** button. The Log Manager Parameters window opens.
3. Change the path in the Log Directory field to `%logdir%/traps`.
4. Click **OK**.

Inventory Manager

If you are using Inventory Manager, you need to change the Data Storage Directory path to point to the new location on the Linux system. The Data Storage directory is where all Inventory Manager data is stored, including capacity planning reports, configuration templates, archived configurations, and property files.

1. From the Inventory Manager menu bar, select **Tools > Options**. Expand the Inventory Manager options folder and select **Data Storage Directory Path**.
2. Change the path to the correct new location. On a default Linux install, the path would be: `<user's home directory>/appdata/InventoryMgr`.
3. Click **OK**.
Systems with Multiple NICs

This section provides instructions for configuring Extreme Management Center servers with multiple NICs (Network Interface Cards). During the startup process, the Extreme Management Center server automatically binds to the first available NIC, which may not be the correct interface for the server to use. In addition, changes on the network can cause the server to bind to an incorrect interface, should the server restart during a change.

If the system has multiple NICs installed, it is a good practice to either:

- configure the server to bind to a preferred IP address, if using only one interface for connections or
- configure multiple network interfaces, if using more than one interface for connections.

This ensures that local and remote clients, as well as ExtremeControl engines, are able to connect to the Extreme Management Center server.

Binding to One Interface

If the Extreme Management Center server has multiple NICs installed but only one interface is used to access Extreme Management Center, use the following instructions to configure the preferred interface for the Extreme Management Center server.

Configure the Extreme Management Center server to bind to the correct IP address.

1. Open the /var/Extreme_Networks/.netsight file. Edit the line JBOSS_HOSTNAME=<server IP> to add the correct NIC IP address.
2. Restart the Extreme Management Center server.

Remote Client Launch

Extreme Management Center is a web-based application you access from the Extreme Management Center Login page. Remote Extreme Management Center clients can use the following steps to access the Extreme Management Center Launch page and run Extreme Management Center applications from the remote client machine.

1. Open a browser window and enter your Extreme Management Center information as a URL in the following format:
http://servername:8080/

where servername is the Extreme Management Center server’s IP address or hostname, and 8080 is the required port number. For example,

http://10.20.30.40:8080/

2. The Extreme Management Center Login page opens.

Extreme Management Center requires a user login as a way to restrict access to the Extreme Management Center server, perform audit trails, and assign user capabilities according to the Authorization Group the user belongs. It is important to note that when you log in, you are authenticating to the operating system of the Extreme Management Center server system to which you are connecting.

3. Enter your username.
4. Enter your password and click Login.
5. The application main window opens.

The first time you log in, the embedded help window displays the Getting Started

**NOTE:** User preferences and application data (such as FlexViews and MIBs) for remote clients are stored in the following local directory on the client machine: C:\Documents and Settings\<username>\Application Data\NetSight.

---

**Uninstalling Extreme Management Center**

Use the procedures below to uninstall your Extreme Management Center Suite of products. The uninstall removes all Extreme Management Center data from the database. Be sure to backup your database prior to uninstalling.

Navigate to the <install directory>/uninstaller directory and start the Uninstaller by issuing the command:

./uninstall.sh

**Extreme Networks Support**

If you require assistance, contact Extreme Networks Global Technical Assistance Center using one of the following methods.

**Web** www.extremenetworks.com/support/
<table>
<thead>
<tr>
<th></th>
<th>Phone</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1-800-872-8440 (toll-free in U.S. and Canada) or 1-603-952-5000</td>
</tr>
<tr>
<td></td>
<td>For the Extreme Networks Support phone number in your country:</td>
</tr>
<tr>
<td></td>
<td><a href="http://www.extremenetworks.com/support/contact/">www.extremenetworks.com/support/contact/</a></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Email</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><a href="mailto:support@extremenetworks.com">support@extremenetworks.com</a></td>
</tr>
</tbody>
</table>